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Pendahuluan

1. Latar Belakang
Waktu dan biaya sangat berpengaruh terhadap
keberhasilan dan kegagalan suatu proyek. Tolak ukur
keberhasilan proyek biasanya dilihat dari waktu
penyelesaian yang singkat dengan biaya yang minimal
tanpa meninggalkan mutu hasil pekerjaan.
Pengelolaan proyek secara sistematis diperlukan
untuk memastikan waktu pelaksanaan proyek sesuai
dengan kontrak atau bahkan lebih cepat sehingga
biaya yang dikeluarkan bisa memberikan keuntungan.
Dan juga menghindarkan dari adanya denda akibat
keterlambatan penyelesaian proyek.



Pendahuluan

2. Tujuan Penelitian

Adapun maksud dan tujuan dilakukannya penelitian
ini adalah sebagai berikut :

a. Menghitung perubahan biaya dan waktu pelaksanan
proyek dengan variasi penambahan jam kerja dari 1
jam lembur sampai 4 jam lembur.

b. Mengetahui penambahan jam kerja yang terbaik
untuk dilakukan.

c. Membandingkan antara biaya denda dengan
perubahan biaya sebelum dan sesudah penambahan
jam kerja (lembur).



Pendahuluan

3. Manfaat Penelitian

Manfaat yang diperoleh dari penelitian ini
adalah sebagai berikut :

a. Sebagai bahan pertimbangan dan masukan bagi
perusahaan dalam mengambil keputusan yang
berkaitan dengan kebijaksanaan pelaksanaan proyek.

b. Sebagai bahan acuan dalam mengembangkan ilmu
pengetahuan khususnya dalam ilmu manajemen
operasional dan dapat digunakan sebagai bahan
kajian untuk penelitian yang akan datang.
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Tinjauan Pustaka

Novitasari (2014), menyebutkan mempercepat waktu
penyelesaian proyek adalah suatu usaha menyelesaikan
proyek lebih awal dari waktu penyelesaian dalam keadaan
normal. Ada kalanya jadwal proyek harus dipercepat
dengan berbagai pertimbangan dari pemilik proyek. Proses
mempercepat kurun waktu tersebut disebut crash
program. Frederika (dikutip oleh Novitasari, 2014)
menyatakan durasi percepatan maksimum dibatasi oleh
luas proyek atau lokasi kerja, namun ada empat faktor yang
dapat dioptimumkan untuk melaksanakan percepatan
suatu aktivitas yaitu meliputi penambahan jumlah tenaga
kerja, penjadwalan lembur, penggunaan alat berat, dan
pengubahan metode konstruksi di lapangan.
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Landasan Teori

1. Metode CPM
CPM (Critical Path Method) adalah suatu metode dengan
mengunakan arrow diagram didalam menentukan lintasan kritis
sehingga kemudian disebut juga sebagai diagram lintasan kritis.

2. Produktivitas Pekerja
Produktivitas didefinisikan sebagai rasio antara output dan input,
atau dapat dikatakan sebagai rasio antara hasil produksi dengan
total sumber daya yang digunakan.

3. Pelaksanaan Penambahan Jam Kerja (Lembur)
Salah satu strategi untuk mempercepat waktu penyelesaian
proyek adalah dengan menambah jam kerja (lembur) para
pekerja. Penambahan dari jam kerja (lembur) ini sangat sering
dilakukan dikarenakan dapat memberdayakan sumber daya yang
sudah ada dilapangan dan cukup dengan mengefisienkan
tambahan biaya yang akan dikeluarkan oleh kontraktor.



Landasan Teori

4. Biaya Tambahan Pekerja (Crash Cost)

Berdasarkan Keputusan Menteri Tenaga Kerja dan Transmigrasi
Republik Indonesia Nomor KEP. 102/MEN/VI/2004 bahwa upah
penambahan kerja bervariasi. Pada penambahan waktu kerja satu
jam pertama, pekerja mendapatkan tambahan upah 1,5 kali upah
perjam waktu normal dan pada penambahan jam kerja berikutnya
maka pekerja akan mendapatkan 2 kali upah perjam waktu
normal.

5. Hubungan Antara Biaya dan Waktu

Biaya total proyek sama dengan penjumlahan dari biaya langsung
dan biaya tidak langsung. Biaya total proyek sangat bergantung
dari waktu penyelesaian proyek.



Hubungan Antara Biaya dan Waktu



Hubungan Antara Biaya dan Waktu



Landasan Teori

6. Biaya Denda
Besarnya biaya denda umumnya dihitung sebagai berikut:
Total denda = total waktu akibat keterlambatan × denda
perhari akibat keterlambatan
Dengan:
Denda perhari akibat keterlambatan sebesar 1 permil dari
nilai kontrak.

7. Program Microsoft Project
Program Microsoft Project adalah sebuah aplikasi program
pengolah lembar kerja untuk manajemen suatu proyek,
pencarian data, serta pembuatan grafik.
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Metode Penelitian

1. Lokasi Penelitian
Objek penelitian ini dilakukan pada Pembangunan Penyebrangan Orang
KM 30+000 dan KM 36+000 pada Jalan Tol Cawang-Tomang-Cengkareng.

2. Pengumpulan Data
Data yang digunakan berupa data sekunder dan data primer berupa hasil
analisis dengan Microsoft Project. Data tersebut meliputi:

a. Daftar bahan dan upah tenaga kerja.

b. Rencana anggaran biaya Pembangunan Penyebrangan Orang KM
30+000 dan KM 36+000 pada Jalan Tol Cawang-Tomang-Cengkareng.

c. Time Schedule (Kurva-S).
d. Estimasi waktu dalam program Microsoft Project.
e. Data biaya normal.

3. Tahap Penelitian
Tahapan penelitian secara skematis dalam bentuk diagram alir dapat
dilihat pada Gambar berikut.



Metode Penelitian
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Hasil dan Pembahasan
1. Data Lapangan

Proyek yang ditinjau dalam penelitian ini adalah Pembangunan Penyebrangan 
Orang KM 30+000 dan KM 36+000 pada Jalan Tol Cawang-Tomang-Cengkareng, 

dengan nilai total proyek sebesar Rp. 25.923.667.330,45 dan waktu
pelaksanaan selama 126 hari kalender, dengan rincian tanggal pekerjaan
dimulai pada 19 September2013 dan tanggal pekerjaan selesai pada 22 Januari
2014. link: Data Lapangan

2. Analisa Data

Analisa percepatan waktu proyek dengan variasi penambahan jam kerja 
(lembur) menggunakan program Microsoft Project 2007, yang meliputi dua
tahapan yakni:

a. Menyusun rencana jadwal dan biaya proyek (baseline).

b. Percepatan waktu proyek dengan variasi penambahan jam kerja (lembur).

Kemudian hasil dari percepatan waktu proyek dengan variasi penambahan jam 
kerja (lembur) berupa perubahan biaya sebelum dan sesudah penambahan
jam kerja (lembur) dibandingkan dengan biaya denda.

Data Lapangan.docx


Langkah – langkah menyusun rencana
jadwal dan biaya proyek (baseline)

1. Membuka lembar kerja baru. Klik tombol Start > Program > Microsoft Office >
Microsoft Project 2007.

2. Memasukkan tanggal dimulainya proyek. Mengaktifkan menu Project > Project
Information. Pada kotak dialog Project Information dipilih Schedule From :
Project Start Date kemudian memasukkan tanggal dimulainya proyek yaitu
tanggal 07 Februari 2014 pada kotak Start Date.

3. Menyusun kalender kerja untuk menentukan hari kerja dan jam kerja. Untuk
memasukkan data tersebut pada Microsoft Project, mula-mula klik menu Tools >
Change Working Time > Work Weeks > Details kemudian pada kotak select
day(s) pilih semua hari kemudian pilih Set day(s) to these spesific working times.
Berikutnya memasukkan jam kerja pada kotak Form: dan To: sesuai jam kerja >
OK. Selanjutnya pada tampilan Work Weeks pilih Options, mengisikan data pada
kotak Default start time:, Default end time:, Hours per day: , Hours per week:,
dan Days per month: sesuai data proyek. Hari libur kalender dimasukkan ke
dalam Exceptions dengan memilih tanggal yang ditentukan libur pada tampilan
kalender kemudian mengetikkan libur pada kotak Name.



Langkah – langkah menyusun rencana
jadwal dan biaya proyek (baseline)

4. Memasukkan data kegiatan proyek dan hubungan antar item pekerjaan.
Item-item pekerjaan pada kegiatan proyek dimasukkan dengan mengetikkan
pada kolom Task Name dan durasi item pekerjaan pada kolom Duration.
Kemudian hubungan antar item pekerjaan dimasukkan pada kolom
Predecessors. Setelah kolom Task Name, Duration, Predecessors terisi
semua maka kolom Start dan Finish akan otomatis terisi dan tampilan
sebelah kanan memperlihatkan hasil berupa Gantt Chart sesuai data yang
dimasukkan.

5. Mengisikan data harga bahan serta data upah dan pekerja. Klik View >
Resources Sheet > mengisi Resource Name sesuai data yang ada. Untuk
tenaga kerja dan sewa peralatan pada kolom Type diisi dengan Work
kemudian biaya per hari atau biaya per jam dimasukkan dalam kolom Std.
Rate, jumlah tenaga kerja dan jumlah sewa alat yang dibutuhkan
dimasukkan dalam kolom Max Units, dan kolom Accrue At diisi dengan
Prorated. Sedangkan untuk bahan dan alat pada kolom Type diisi dengan
Material, tipe satuan jumlah bahan dan alat diketikkan pada kolom Material
Label, kemudian harga per satuan jumlah dimasukkan dalam kolom Std.
Rate dan kolom Accrue At diisi dengan Start.



Langkah – langkah menyusun rencana
jadwal dan biaya proyek (baseline)

6. Memasukkan resource dari setiap item pekerjaan pada kegiatan
proyek. Mula-mula membagi layar Microsoft Project menjadi dua
(atas dan bawah) untuk memasukan resource dari item-item
pekerjaan, yakni layar atas berupa Gantt Chart View dan layar bawah
berupa Task Information dengan cara klik menu Window > Split.
Resource dari item pekerjaan diisi berdasarkan Analisis Harga Satuan
dan Analisa Jumlah Resource (terlampir). Mula-mula pilih Resource
Name untuk item-item pekerjaan seperti yang tercantum pada
Analisa Harga Satuan. Kolom Units diisi sesuai jumlah pada Analisis
Jumlah Resource sedangkan untuk kolom Work adalah jam kerja
sesuai pada Analisis Jumlah Resource.

7. Menyimpan rencana jadwal dan biaya sebagai baseline. Klik menu
Tools > Tracking > Set Baseline > pilih Set baseline dan For: Entire
project.



Memasukkan tanggal dimulainya 
proyek



Memasukkan hari kerja dan jam kerja



Memasukkkan jam kerja per hari, jam kerja 
per minggu, dan hari kerja per bulan



Memasukkan hari libur kalender



Penyusunan pekerjaan dan tampilan 
Gantt Chart



Pengisian data harga bahan, upah, dan 
alat



Memasukkan resource tiap item 
pekerjaan



Menyimpan rencana jadwal dan biaya



Baseline Kondisi Normal

No 

Task.
Task Name Duration Cost

1

PEMBANGUNAN JEMBATAN PENYEBERANGAN ORANG ( JPO ) KM 30+000 DAN KM 30+600 

PADA JALAN TOL CAWANG - TOMANG - CENGKARENG 126 Rp3.523.060.709,46

2 UMUM 126 Rp245.523.200,00

3 JEMBATAN PENYEBRANGAN STA 30+000 126 Rp122.761.600,00

4 Pemeliharaan dan Perlindungan Lalu Lintas 126 Rp92.761.600,00

5 Mobilisasi (yang tidak Tercakup pada 1.20(1) 126 Rp30.000.000,00

6 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag awal 14 Rp15.000.000,00

7 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag akhir 14 Rp15.000.000,00

8 JEMBATAN PENYEBRANGAN STA 30+600 126 Rp122.761.600,00

9 Pemeliharaan dan Perlindungan Lalu Lintas 126 Rp92.761.600,00

10 Mobilisasi (yang tidak Tercakup pada 1.20(1) 126 Rp30.000.000,00

11 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag awal 14 Rp15.000.000,00

12 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag akhir 14 Rp15.000.000,00

13 PEMBONGKARAN 28 Rp70.000.000,00

14 Pembongkaran Jembatan (JPO) Eksisting 28 Rp70.000.000,00

15 GALIAN STRUKTUR 35 Rp25.714.000,00

16 Penggalian Struktur sampai kedalaman tidak lebih dari  2 m 35 Rp23.944.000,00

17 Penggalian Struktur sampai kedalaman lebih dari  2 m, tapi tidak lebih dari 4 m 35 Rp1.770.000,00

18 DRAINASE 35 Rp34.126.875,00

19 Pipa drainase Ø 20 cm dengan perlengkapan sambungan dan penyangga 35 Rp28.251.875,00

20 Deck Drain beserta asessorisnya, type 1 35 Rp5.875.000,00

21 STRUKTUR BETON 91 Rp2.752.491.749,46

22 Beton Klass B-1-1 (Plat Jembatan) 28 Rp128.613.248,16

23 Beton Klass B-1-2 (Beton Tangga) 42 Rp270.759.197,20

24 Beton Klass B-4-1 (Pier Head) 28 Rp58.215.269,10

25 Beton Klass B-4-2 (Coloums Pier + Wall Pier) 28 Rp57.797.479,90

26 Beton Klass C-1 (Abutment, Footing of Pier) 28 Rp194.576.650,90

27 Beton Klass E (Lantai Kerja) 28 Rp12.661.350,00

28 Baja Tulangan Ulir 84 Rp852.326.583,00

29 P.C.I. Girder, Bentang = 23,60 m, H = 1,60 m 77 Rp318.958.570,00

30 Penyediaan Tiang Pancang  Beton Bulat Pretensioned Dia. 60 cm 28 Rp585.317.754,00

31 Pemancangan Tiang Pancang  Beton Bulat Pretensioned Dia. 60 cm 28 Rp147.065.647,20

32 Sambungan Expansi (Expansion Joint) Fix 28 Rp26.000.000,00

33 Sambungan Expansi (Expansion Joint) Move 28 Rp31.200.000,00

34 Bearing Pad dengan aksesoris ukuran (400 x 350 x 39 mm) 28 Rp20.000.000,00

35 Rubber Pad dengan aksesoris ukuran (400 x 350 x 39 mm) 28 Rp25.000.000,00

36 Rubber Strip ukuran (200 x 200 x 10 mm) 28 Rp24.000.000,00

37 PEKERJAAN LAIN-LAIN 42 Rp395.204.885,00

38 Pagar Pengaman / Railling, Tipe 1 (Tangga) 28 Rp257.723.572,00

39 Pagar Pengaman / Railling, Tipe 2 (Jembatan) 28 Rp137.481.313,00



Baseline Kondisi Normal (lanjutan)

No 

Task.
Task Name Duration Cost

1

PEMBANGUNAN JEMBATAN PENYEBERANGAN ORANG ( JPO ) KM 30+000 DAN KM 30+600 

PADA JALAN TOL CAWANG - TOMANG - CENGKARENG 126 Rp3.523.060.709,46

2 UMUM 126 Rp245.523.200,00

3 JEMBATAN PENYEBRANGAN STA 30+000 126 Rp122.761.600,00

4 Pemeliharaan dan Perlindungan Lalu Lintas 126 Rp92.761.600,00

5 Mobilisasi (yang tidak Tercakup pada 1.20(1) 126 Rp30.000.000,00

6 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag awal 14 Rp15.000.000,00

7 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag akhir 14 Rp15.000.000,00

8 JEMBATAN PENYEBRANGAN STA 30+600 126 Rp122.761.600,00

9 Pemeliharaan dan Perlindungan Lalu Lintas 126 Rp92.761.600,00

10 Mobilisasi (yang tidak Tercakup pada 1.20(1) 126 Rp30.000.000,00

11 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag awal 14 Rp15.000.000,00

12 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag akhir 14 Rp15.000.000,00

13 PEMBONGKARAN 28 Rp70.000.000,00

14 Pembongkaran Jembatan (JPO) Eksisting 28 Rp70.000.000,00

15 GALIAN STRUKTUR 35 Rp25.714.000,00

16 Penggalian Struktur sampai kedalaman tidak lebih dari  2 m 35 Rp23.944.000,00

17 Penggalian Struktur sampai kedalaman lebih dari  2 m, tapi tidak lebih dari 4 m 35 Rp1.770.000,00

18 DRAINASE 35 Rp34.126.875,00

19 Pipa drainase Ø 20 cm dengan perlengkapan sambungan dan penyangga 35 Rp28.251.875,00

20 Deck Drain beserta asessorisnya, type 1 35 Rp5.875.000,00

21 STRUKTUR BETON 91 Rp2.752.491.749,46

22 Beton Klass B-1-1 (Plat Jembatan) 28 Rp128.613.248,16

23 Beton Klass B-1-2 (Beton Tangga) 42 Rp270.759.197,20

24 Beton Klass B-4-1 (Pier Head) 28 Rp58.215.269,10

25 Beton Klass B-4-2 (Coloums Pier + Wall Pier) 28 Rp57.797.479,90

26 Beton Klass C-1 (Abutment, Footing of Pier) 28 Rp194.576.650,90

27 Beton Klass E (Lantai Kerja) 28 Rp12.661.350,00

28 Baja Tulangan Ulir 84 Rp852.326.583,00

29 P.C.I. Girder, Bentang = 23,60 m, H = 1,60 m 77 Rp318.958.570,00

30 Penyediaan Tiang Pancang  Beton Bulat Pretensioned Dia. 60 cm 28 Rp585.317.754,00

31 Pemancangan Tiang Pancang  Beton Bulat Pretensioned Dia. 60 cm 28 Rp147.065.647,20

32 Sambungan Expansi (Expansion Joint) Fix 28 Rp26.000.000,00

33 Sambungan Expansi (Expansion Joint) Move 28 Rp31.200.000,00

34 Bearing Pad dengan aksesoris ukuran (400 x 350 x 39 mm) 28 Rp20.000.000,00

35 Rubber Pad dengan aksesoris ukuran (400 x 350 x 39 mm) 28 Rp25.000.000,00

36 Rubber Strip ukuran (200 x 200 x 10 mm) 28 Rp24.000.000,00

37 PEKERJAAN LAIN-LAIN 42 Rp395.204.885,00

38 Pagar Pengaman / Railling, Tipe 1 (Tangga) 28 Rp257.723.572,00

39 Pagar Pengaman / Railling, Tipe 2 (Jembatan) 28 Rp137.481.313,00

No 

Task.
Task Name Duration Cost

1

PEMBANGUNAN JEMBATAN PENYEBERANGAN ORANG ( JPO ) KM 30+000 DAN KM 30+600 

PADA JALAN TOL CAWANG - TOMANG - CENGKARENG 126 Rp3.523.060.709,46

2 UMUM 126 Rp245.523.200,00

3 JEMBATAN PENYEBRANGAN STA 30+000 126 Rp122.761.600,00

4 Pemeliharaan dan Perlindungan Lalu Lintas 126 Rp92.761.600,00

5 Mobilisasi (yang tidak Tercakup pada 1.20(1) 126 Rp30.000.000,00

6 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag awal 14 Rp15.000.000,00

7 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag akhir 14 Rp15.000.000,00

8 JEMBATAN PENYEBRANGAN STA 30+600 126 Rp122.761.600,00

9 Pemeliharaan dan Perlindungan Lalu Lintas 126 Rp92.761.600,00

10 Mobilisasi (yang tidak Tercakup pada 1.20(1) 126 Rp30.000.000,00

11 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag awal 14 Rp15.000.000,00

12 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag akhir 14 Rp15.000.000,00

13 PEMBONGKARAN 28 Rp70.000.000,00

14 Pembongkaran Jembatan (JPO) Eksisting 28 Rp70.000.000,00

15 GALIAN STRUKTUR 35 Rp25.714.000,00

16 Penggalian Struktur sampai kedalaman tidak lebih dari  2 m 35 Rp23.944.000,00

17 Penggalian Struktur sampai kedalaman lebih dari  2 m, tapi tidak lebih dari 4 m 35 Rp1.770.000,00

18 DRAINASE 35 Rp34.126.875,00

19 Pipa drainase Ø 20 cm dengan perlengkapan sambungan dan penyangga 35 Rp28.251.875,00

20 Deck Drain beserta asessorisnya, type 1 35 Rp5.875.000,00

21 STRUKTUR BETON 91 Rp2.752.491.749,46

22 Beton Klass B-1-1 (Plat Jembatan) 28 Rp128.613.248,16

23 Beton Klass B-1-2 (Beton Tangga) 42 Rp270.759.197,20

24 Beton Klass B-4-1 (Pier Head) 28 Rp58.215.269,10

25 Beton Klass B-4-2 (Coloums Pier + Wall Pier) 28 Rp57.797.479,90

26 Beton Klass C-1 (Abutment, Footing of Pier) 28 Rp194.576.650,90

27 Beton Klass E (Lantai Kerja) 28 Rp12.661.350,00

28 Baja Tulangan Ulir 84 Rp852.326.583,00

29 P.C.I. Girder, Bentang = 23,60 m, H = 1,60 m 77 Rp318.958.570,00

30 Penyediaan Tiang Pancang  Beton Bulat Pretensioned Dia. 60 cm 28 Rp585.317.754,00

31 Pemancangan Tiang Pancang  Beton Bulat Pretensioned Dia. 60 cm 28 Rp147.065.647,20

32 Sambungan Expansi (Expansion Joint) Fix 28 Rp26.000.000,00

33 Sambungan Expansi (Expansion Joint) Move 28 Rp31.200.000,00

34 Bearing Pad dengan aksesoris ukuran (400 x 350 x 39 mm) 28 Rp20.000.000,00

35 Rubber Pad dengan aksesoris ukuran (400 x 350 x 39 mm) 28 Rp25.000.000,00

36 Rubber Strip ukuran (200 x 200 x 10 mm) 28 Rp24.000.000,00

37 PEKERJAAN LAIN-LAIN 42 Rp395.204.885,00

38 Pagar Pengaman / Railling, Tipe 1 (Tangga) 28 Rp257.723.572,00

39 Pagar Pengaman / Railling, Tipe 2 (Jembatan) 28 Rp137.481.313,00



Langkah – langkah percepatan waktu proyek
dengan variasi penambahan jam kerja (lembur)

1. Pada tampilan Gantt Chart menambahkan kolom Baseline
Duration, Duration Variance, Baseline Start, Baseline Finish,
Baseline Cost, Cost Variance, dan Overtime Cost. Caranya
adalah klik kanan pada tampilan Gantt Chart > Insert Column
> pilih Field Name sesuai yang diinginkan.

2. Memasukkan durasi item pekerjaan sesuai rencana crash.
Mula-mula membagi layar Microsoft Project menjadi dua
dengan cara klik menu Window > Split. Pilih item pekerjaan
yang akan dilakukan percepatan lalu masukkan durasi crash
sesuai perhitungan pada kotak Duration di bagian Task
Information (sebelah bawah).



Langkah – langkah percepatan waktu proyek
dengan variasi penambahan jam kerja (lembur)

3. Memasukkan biaya lembur per jam. Klik menu View >
Resource Sheet. Besarnya biaya lembur dimasukan dalam
kolom Ovt. Rate. Biaya lembur dimasukkan sesuai dari hasil
perhitungan.

4. Memasukkan jam lembur sesuai dengan perhitungan. Mula-
mula membagi layar Microsoft Project menjadi dua dengan
cara klik menu Window > Split. Pilih item pekerjaan yang
akan dimasukkan jam lembur berdasarkan hasil perhitungan,
kemudian masukan jam lembur sesuai Resource Name pada
kolom Work dan Ovt. Work di bagian Task Information
(sebelah bawah).



Memunculkan data baseline



Memasukkan durasi crash



Memasukan biaya lembur per jam



Memasukkan jam lembur



Hasil dan Pembahasan
3. Pembahasan

• Perhitungan kebutuhan percepatan dengan penambahan lembur 1 jam yang
diinputkan pada kondisi normal menyebabkan timbulnya lintasan kritis baru
dengan adanya pengurangan waktu pelaksaaan proyek dari 126 hari menjadi
122,81 hari. Percepatan ini menyebabkan kebutuhan biaya proyek
mengalami kenaikan biaya yang mencapai Rp. 36.268.544,50 dari biaya
rencana semula, yakni sebesar Rp. 3.523.060.709,46 menjadi sebesar Rp.
3.559.329.253,96..

• Kompresi pada penambahan jam lembur dua jam memberikan hasil berupa
waktu penyelesaian proyek yaitu 120,79 hari atau berkurang 5,21 hari dari
kondisi normal 217 hari dengan total biaya yang diperlukan sebesar Rp.
3.608.100.449,23 yang berarti mengalami pertambahan sebesar Rp.
85.039.739,77 dari biaya rencana semula.

• Kompresi untuk penambahan jam lembur tiga jam mendapatkan hasil
berupa waktu penyelesaian proyek yaitu 119,54 hari yang artinya lebih cepat
6,46 hari dari waktu rencana, dengan total biaya yang diperlukan sebesar Rp.
3.657.160.089,52 yang berarti mengalami pertambahan sebesar Rp.
134.099.380,06 dari biaya rencana semula.



Hasil dan Pembahasan (lanjutan)

3. Pembahasan
• Kompresi untuk penambahan jam lembur empat jam mendapatkan hasil berupa

waktu penyelesaian proyek yaitu 119,00 hari; berkurang 7,00 hari dari waktu
rencana yaitu 126 hari. Total biaya yang diperlukan pada tahap ini sebesar Rp.
3.709.594.308,26 yang berarti mengalami pertambahan sebesar Rp.
186.533.598,81 dari biaya rencana semula.

• Grafik hubungan waktu dan biaya memperlihatkan bahwa semakin cepat waktu
pelaksanaan proyek akibat dari penambahan jam kerja (lembur) maka semakin
besar biaya total pelaksanaan proyek yang harus dikeluarkan dan semakin cepat
waktu pelaksanaan proyek maka semakin besar juga biaya langsung dari proyek
tersebut. Sementara untuk biaya tidak langsung grafik menunjukkan bahwa
semakin cepat waktu pelaksanaan proyek maka semakin kecil besar biaya tidak
langsung. Selain itu tidak dapat terlihat biaya total optimum pada grafik tersebut.
Hal ini dikarenakan besarnya biaya tidak langsung tidak dapat untuk
mengimbangi besarnya biaya langsung.



Hasil dan Pembahasan (lanjutan)

3. Pembahasan
• Besar durasi keterlambatan didapatkan dari pembulatan durasi

setelah dilakukan percepatan, kemudian dilakukan perhitungan
besar biaya denda. Hasil dari perbandingan antara biaya denda
dan penambahan biaya akibat kompresi menunjukkan bahwa
penambahan biaya akibat kompresi pada semua kondisi lebih
besar dibandingkan dengan biaya denda apabila terjadi
keterlambatan. Hal ini berarti kurang baik untuk melakukan
kompresi dengan menambah jam kerja dibandingkan dengan
membayar denda akibat keterlambatan karena dapat memberikan
kerugian. Besar kerugian didapatkan dari selisih antara biaya
denda dengan penambahan biaya akibat kompresi.



Perbandingan Kondisi Normal dengan Penambahan Lembur 1 Jam

Normal
Lembur 1 

Jam
Normal Lembur 1 Jam Normal Lembur 1 Jam Normal Lembur 1 Jam

1

PEMBANGUNAN JEMBATAN PENYEBERANGAN ORANG ( JPO ) KM 30+000 DAN KM 30+600 

PADA JALAN TOL CAWANG - TOMANG - CENGKARENG 126 122,81 -3,19 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 19/01/2014 14:40 Rp3.523.060.709,46 Rp3.559.329.253,96 Rp36.268.544,50 Rp60.787.335,27 (11.369.449,69)Rp   

2 UMUM 126 122,81 -3,19 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 19/01/2014 14:40 Rp245.523.200,00 Rp250.710.992,43 Rp5.187.792,43 Rp15.870.719,06 (1.626.267,22)Rp     

3 JEMBATAN PENYEBRANGAN STA 30+000 126 122,81 -3,19 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 19/01/2014 14:40 Rp122.761.600,00 Rp125.355.496,21 Rp2.593.896,21 Rp7.935.359,53 (813.133,61)Rp        

4 Pemeliharaan dan Perlindungan Lalu Lintas 126 111,65 -14,35 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 08/01/2014 13:33 Rp92.761.600,00 Rp95.355.496,21 Rp2.593.896,21 Rp7.935.359,53 (180.759,32)Rp        

5 Mobilisasi (yang tidak Tercakup pada 1.20(1) 126 122,81 -3,19 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 19/01/2014 14:40 Rp30.000.000,00 Rp30.000.000,00 Rp0,00 Rp0,00 -Rp                        

6 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag awal 14 14 0 19/09/2013 8:00 19/09/2013 8:00 02/10/2013 16:00 02/10/2013 16:00 Rp15.000.000,00 Rp15.000.000,00 Rp0,00 Rp0,00

7 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag akhir 14 14 0 09/01/2014 8:00 05/01/2014 14:40 22/01/2014 16:00 19/01/2014 14:40 Rp15.000.000,00 Rp15.000.000,00 Rp0,00 Rp0,00

8 JEMBATAN PENYEBRANGAN STA 30+600 126 122,81 -3,19 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 19/01/2014 14:40 Rp122.761.600,00 Rp125.355.496,21 Rp2.593.896,21 Rp7.935.359,53 (813.133,61)Rp        

9 Pemeliharaan dan Perlindungan Lalu Lintas 126 111,65 -14,35 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 08/01/2014 13:33 Rp92.761.600,00 Rp95.355.496,21 Rp2.593.896,21 Rp7.935.359,53 (180.759,32)Rp        

10 Mobilisasi (yang tidak Tercakup pada 1.20(1) 126 122,81 -3,19 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 19/01/2014 14:40 Rp30.000.000,00 Rp30.000.000,00 Rp0,00 Rp0,00 -Rp                        

11 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag awal 14 14 0 19/09/2013 8:00 19/09/2013 8:00 02/10/2013 16:00 02/10/2013 16:00 Rp15.000.000,00 Rp15.000.000,00 Rp0,00 Rp0,00

12 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag akhir 14 14 0 09/01/2014 8:00 05/01/2014 14:40 22/01/2014 16:00 19/01/2014 14:40 Rp15.000.000,00 Rp15.000.000,00 Rp0,00 Rp0,00

13 PEMBONGKARAN 28 28 0 12/12/2013 8:00 12/12/2013 8:00 08/01/2014 16:00 08/01/2014 16:00 Rp70.000.000,00 Rp70.000.000,00 Rp0,00 Rp0,00

14 Pembongkaran Jembatan (JPO) Eksisting 28 28 0 12/12/2013 8:00 12/12/2013 8:00 08/01/2014 16:00 08/01/2014 16:00 Rp70.000.000,00 Rp70.000.000,00 Rp0,00 Rp0,00

15 GALIAN STRUKTUR 35 35 0 03/10/2013 8:00 03/10/2013 8:00 06/11/2013 16:00 06/11/2013 16:00 Rp25.714.000,00 Rp25.714.000,00 Rp0,00 Rp0,00

16 Penggalian Struktur sampai kedalaman tidak lebih dari  2 m 35 35 0 03/10/2013 8:00 03/10/2013 8:00 06/11/2013 16:00 06/11/2013 16:00 Rp23.944.000,00 Rp23.944.000,00 Rp0,00 Rp0,00

17 Penggalian Struktur sampai kedalaman lebih dari  2 m, tapi tidak lebih dari 4 m 35 35 0 03/10/2013 8:00 03/10/2013 8:00 06/11/2013 16:00 06/11/2013 16:00 Rp1.770.000,00 Rp1.770.000,00 Rp0,00 Rp0,00

18 DRAINASE 35 35 0 07/11/2013 8:00 07/11/2013 8:00 11/12/2013 16:00 11/12/2013 16:00 Rp34.126.875,00 Rp34.126.875,00 Rp0,00 Rp0,00

19 Pipa drainase Ø 20 cm dengan perlengkapan sambungan dan penyangga 35 35 0 07/11/2013 8:00 07/11/2013 8:00 11/12/2013 16:00 11/12/2013 16:00 Rp28.251.875,00 Rp28.251.875,00 Rp0,00 Rp0,00

20 Deck Drain beserta asessorisnya, type 1 35 35 0 07/11/2013 8:00 07/11/2013 8:00 11/12/2013 16:00 11/12/2013 16:00 Rp5.875.000,00 Rp5.875.000,00 Rp0,00 Rp0,00

21 STRUKTUR BETON 91 87,81 -3,19 10/10/2013 8:00 10/10/2013 8:00 08/01/2014 16:00 05/01/2014 14:40 Rp2.752.491.749,46 Rp2.779.441.890,13 Rp26.950.140,67 Rp40.168.259,72 (8.448.319,96)Rp     

22 Beton Klass B-1-1 (Plat Jembatan) 28 28 0 12/12/2013 8:00 08/12/2013 14:40 08/01/2014 16:00 05/01/2014 14:40 Rp128.613.248,16 Rp128.613.248,16 Rp0,00 Rp0,00

23 Beton Klass B-1-2 (Beton Tangga) 42 42 0 14/11/2013 8:00 10/11/2013 14:40 25/12/2013 16:00 22/12/2013 14:40 Rp270.759.197,20 Rp270.759.197,20 Rp0,00 Rp0,00

24 Beton Klass B-4-1 (Pier Head) 28 24,81 -3,19 21/11/2013 8:00 17/11/2013 14:40 18/12/2013 16:00 12/12/2013 13:22 Rp58.215.269,10 Rp65.202.601,40 Rp6.987.332,30 Rp7.994.749,85 (2.190.386,30)Rp     

25 Beton Klass B-4-2 (Coloums Pier + Wall Pier) 28 24,81 -3,19 07/11/2013 8:00 07/11/2013 8:00 04/12/2013 16:00 01/12/2013 14:40 Rp57.797.479,90 Rp65.213.428,88 Rp7.415.948,98 Rp8.599.637,56 (2.324.748,90)Rp     

26 Beton Klass C-1 (Abutment, Footing of Pier) 28 28 0 31/10/2013 8:00 31/10/2013 8:00 27/11/2013 16:00 27/11/2013 16:00 Rp194.576.650,90 Rp194.576.650,90 Rp0,00 Rp0,00

27 Beton Klass E (Lantai Kerja) 28 28 0 24/10/2013 8:00 24/10/2013 8:00 20/11/2013 16:00 20/11/2013 16:00 Rp12.661.350,00 Rp12.661.350,00 Rp0,00 Rp0,00

28 Baja Tulangan Ulir 84 74,43 -9,57 17/10/2013 8:00 17/10/2013 8:00 08/01/2014 16:00 30/12/2013 11:01 Rp852.326.583,00 Rp864.873.442,40 Rp12.546.859,40 Rp23.573.872,30 (1.311.061,59)Rp     

29 P.C.I. Girder, Bentang = 23,60 m, H = 1,60 m 77 77 0 17/10/2013 8:00 17/10/2013 8:00 01/01/2014 16:00 01/01/2014 16:00 Rp318.958.570,00 Rp318.958.570,00 Rp0,00 Rp0,00

30 Penyediaan Tiang Pancang  Beton Bulat Pretensioned Dia. 60 cm 28 28 0 10/10/2013 8:00 10/10/2013 8:00 06/11/2013 16:00 06/11/2013 16:00 Rp585.317.754,00 Rp585.317.754,00 Rp0,00 Rp0,00

31 Pemancangan Tiang Pancang  Beton Bulat Pretensioned Dia. 60 cm 28 28 0 17/10/2013 8:00 17/10/2013 8:00 13/11/2013 16:00 13/11/2013 16:00 Rp147.065.647,20 Rp147.065.647,20 Rp0,00 Rp0,00

32 Sambungan Expansi (Expansion Joint) Fix 28 28 0 21/11/2013 8:00 21/11/2013 8:00 18/12/2013 16:00 18/12/2013 16:00 Rp26.000.000,00 Rp26.000.000,00 Rp0,00 Rp0,00

33 Sambungan Expansi (Expansion Joint) Move 28 28 0 21/11/2013 8:00 21/11/2013 8:00 18/12/2013 16:00 18/12/2013 16:00 Rp31.200.000,00 Rp31.200.000,00 Rp0,00 Rp0,00

34 Bearing Pad dengan aksesoris ukuran (400 x 350 x 39 mm) 28 28 0 21/11/2013 8:00 21/11/2013 8:00 18/12/2013 16:00 18/12/2013 16:00 Rp20.000.000,00 Rp20.000.000,00 Rp0,00 Rp0,00

35 Rubber Pad dengan aksesoris ukuran (400 x 350 x 39 mm) 28 28 0 21/11/2013 8:00 21/11/2013 8:00 18/12/2013 16:00 18/12/2013 16:00 Rp25.000.000,00 Rp25.000.000,00 Rp0,00 Rp0,00

36 Rubber Strip ukuran (200 x 200 x 10 mm) 28 28 0 21/11/2013 8:00 21/11/2013 8:00 18/12/2013 16:00 18/12/2013 16:00 Rp24.000.000,00 Rp24.000.000,00 Rp0,00 Rp0,00

37 PEKERJAAN LAIN-LAIN 42 38,81 -3,19 05/12/2013 8:00 01/12/2013 14:40 15/01/2014 16:00 09/01/2014 13:20 Rp395.204.885,00 Rp399.335.496,40 Rp4.130.611,40 Rp4.748.356,50 (1.294.862,51)Rp     

38 Pagar Pengaman / Railling, Tipe 1 (Tangga) 28 28 0 19/12/2013 8:00 12/12/2013 13:20 15/01/2014 16:00 09/01/2014 13:20 Rp257.723.572,00 Rp257.723.572,00 Rp0,00 Rp0,00

39 Pagar Pengaman / Railling, Tipe 2 (Jembatan) 28 24,81 -3,19 05/12/2013 8:00 01/12/2013 14:40 01/01/2014 16:00 26/12/2013 13:20 Rp137.481.313,00 Rp141.611.924,40 Rp4.130.611,40 Rp4.748.356,50 (1.294.862,51)Rp     

No 

Task.
Task Name

Duration
Duration 

Variance

Start Finish Cost

Cost Variance Overtime Cost Cost Slope



Kondisi Normal dengan Penambahan Lembur 2 Jam

Normal
Lembur 2 

Jam
Normal Lembur 2 Jam Normal Lembur 2 Jam Normal Lembur 2 Jam

1

PEMBANGUNAN JEMBATAN PENYEBERANGAN ORANG ( JPO ) KM 30+000 DAN KM 30+600 

PADA JALAN TOL CAWANG - TOMANG - CENGKARENG 126 120,79 -5,21 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 17/01/2014 14:33 Rp3.523.060.709,46 Rp3.608.100.449,23 Rp85.039.739,77 Rp125.519.660,60 (16.322.406,87)Rp   

2 UMUM 126 120,79 -5,21 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 17/01/2014 14:33 Rp245.523.200,00 Rp259.644.617,77 Rp14.121.417,77 Rp32.051.802,80 (2.710.444,87)Rp     

3 JEMBATAN PENYEBRANGAN STA 30+000 126 120,79 -5,21 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 17/01/2014 14:33 Rp122.761.600,00 Rp129.822.308,89 Rp7.060.708,89 Rp16.025.901,40 (1.355.222,43)Rp     

4 Pemeliharaan dan Perlindungan Lalu Lintas 126 102,56 -23,44 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 30/12/2013 11:55 Rp92.761.600,00 Rp99.822.308,89 Rp7.060.708,89 Rp16.025.901,40 (301.224,78)Rp        

5 Mobilisasi (yang tidak Tercakup pada 1.20(1) 126 120,79 -5,21 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 17/01/2014 14:33 Rp30.000.000,00 Rp30.000.000,00 Rp0,00 Rp0,00 -Rp                        

6 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag awal 14 14 0 19/09/2013 8:00 19/09/2013 8:00 02/10/2013 16:00 02/10/2013 16:00 Rp15.000.000,00 Rp15.000.000,00 Rp0,00 Rp0,00

7 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag akhir 14 14 0 09/01/2014 8:00 03/01/2014 14:33 22/01/2014 16:00 17/01/2014 14:33 Rp15.000.000,00 Rp15.000.000,00 Rp0,00 Rp0,00

8 JEMBATAN PENYEBRANGAN STA 30+600 126 120,79 -5,21 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 17/01/2014 14:33 Rp122.761.600,00 Rp129.822.308,89 Rp7.060.708,89 Rp16.025.901,40 (1.355.222,43)Rp     

9 Pemeliharaan dan Perlindungan Lalu Lintas 126 102,56 -23,44 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 30/12/2013 11:55 Rp92.761.600,00 Rp99.822.308,89 Rp7.060.708,89 Rp16.025.901,40 (301.224,78)Rp        

10 Mobilisasi (yang tidak Tercakup pada 1.20(1) 126 120,79 -5,21 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 17/01/2014 14:33 Rp30.000.000,00 Rp30.000.000,00 Rp0,00 Rp0,00 -Rp                        

11 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag awal 14 14 0 19/09/2013 8:00 19/09/2013 8:00 02/10/2013 16:00 02/10/2013 16:00 Rp15.000.000,00 Rp15.000.000,00 Rp0,00 Rp0,00

12 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag akhir 14 14 0 09/01/2014 8:00 03/01/2014 14:33 22/01/2014 16:00 17/01/2014 14:33 Rp15.000.000,00 Rp15.000.000,00 Rp0,00 Rp0,00

13 PEMBONGKARAN 28 28 0 12/12/2013 8:00 12/12/2013 8:00 08/01/2014 16:00 08/01/2014 16:00 Rp70.000.000,00 Rp70.000.000,00 Rp0,00 Rp0,00

14 Pembongkaran Jembatan (JPO) Eksisting 28 28 0 12/12/2013 8:00 12/12/2013 8:00 08/01/2014 16:00 08/01/2014 16:00 Rp70.000.000,00 Rp70.000.000,00 Rp0,00 Rp0,00

15 GALIAN STRUKTUR 35 35 0 03/10/2013 8:00 03/10/2013 8:00 06/11/2013 16:00 06/11/2013 16:00 Rp25.714.000,00 Rp25.714.000,00 Rp0,00 Rp0,00

16 Penggalian Struktur sampai kedalaman tidak lebih dari  2 m 35 35 0 03/10/2013 8:00 03/10/2013 8:00 06/11/2013 16:00 06/11/2013 16:00 Rp23.944.000,00 Rp23.944.000,00 Rp0,00 Rp0,00

17 Penggalian Struktur sampai kedalaman lebih dari  2 m, tapi tidak lebih dari 4 m 35 35 0 03/10/2013 8:00 03/10/2013 8:00 06/11/2013 16:00 06/11/2013 16:00 Rp1.770.000,00 Rp1.770.000,00 Rp0,00 Rp0,00

18 DRAINASE 35 35 0 07/11/2013 8:00 07/11/2013 8:00 11/12/2013 16:00 11/12/2013 16:00 Rp34.126.875,00 Rp34.126.875,00 Rp0,00 Rp0,00

19 Pipa drainase Ø 20 cm dengan perlengkapan sambungan dan penyangga 35 35 0 07/11/2013 8:00 07/11/2013 8:00 11/12/2013 16:00 11/12/2013 16:00 Rp28.251.875,00 Rp28.251.875,00 Rp0,00 Rp0,00

20 Deck Drain beserta asessorisnya, type 1 35 35 0 07/11/2013 8:00 07/11/2013 8:00 11/12/2013 16:00 11/12/2013 16:00 Rp5.875.000,00 Rp5.875.000,00 Rp0,00 Rp0,00

21 STRUKTUR BETON 91 85,79 -5,21 10/10/2013 8:00 10/10/2013 8:00 08/01/2014 16:00 03/01/2014 14:33 Rp2.752.491.749,46 Rp2.814.640.421,86 Rp62.148.672,40 Rp83.629.731,90 (11.928.727,91)Rp   

22 Beton Klass B-1-1 (Plat Jembatan) 28 28 0 12/12/2013 8:00 06/12/2013 14:33 08/01/2014 16:00 03/01/2014 14:33 Rp128.613.248,16 Rp128.613.248,16 Rp0,00 Rp0,00

23 Beton Klass B-1-2 (Beton Tangga) 42 42 0 14/11/2013 8:00 08/11/2013 14:33 25/12/2013 16:00 20/12/2013 14:33 Rp270.759.197,20 Rp270.759.197,20 Rp0,00 Rp0,00

24 Beton Klass B-4-1 (Pier Head) 28 22,79 -5,21 21/11/2013 8:00 15/11/2013 14:33 18/12/2013 16:00 08/12/2013 13:05 Rp58.215.269,10 Rp73.390.208,37 Rp15.174.939,27 Rp16.893.627,70 (2.912.656,29)Rp     

25 Beton Klass B-4-2 (Coloums Pier + Wall Pier) 28 22,79 -5,21 07/11/2013 8:00 07/11/2013 8:00 04/12/2013 16:00 29/11/2013 14:33 Rp57.797.479,90 Rp74.041.229,98 Rp16.243.750,08 Rp18.189.666,55 (3.117.802,32)Rp     

26 Beton Klass C-1 (Abutment, Footing of Pier) 28 28 0 31/10/2013 8:00 31/10/2013 8:00 27/11/2013 16:00 27/11/2013 16:00 Rp194.576.650,90 Rp194.576.650,90 Rp0,00 Rp0,00

27 Beton Klass E (Lantai Kerja) 28 28 0 24/10/2013 8:00 24/10/2013 8:00 20/11/2013 16:00 20/11/2013 16:00 Rp12.661.350,00 Rp12.661.350,00 Rp0,00 Rp0,00

28 Baja Tulangan Ulir 84 68,37 -15,63 17/10/2013 8:00 17/10/2013 8:00 08/01/2014 16:00 24/12/2013 10:35 Rp852.326.583,00 Rp883.056.566,05 Rp30.729.983,05 Rp48.546.437,65 (1.966.089,77)Rp     

29 P.C.I. Girder, Bentang = 23,60 m, H = 1,60 m 77 77 0 17/10/2013 8:00 17/10/2013 8:00 01/01/2014 16:00 01/01/2014 16:00 Rp318.958.570,00 Rp318.958.570,00 Rp0,00 Rp0,00

30 Penyediaan Tiang Pancang  Beton Bulat Pretensioned Dia. 60 cm 28 28 0 10/10/2013 8:00 10/10/2013 8:00 06/11/2013 16:00 06/11/2013 16:00 Rp585.317.754,00 Rp585.317.754,00 Rp0,00 Rp0,00

31 Pemancangan Tiang Pancang  Beton Bulat Pretensioned Dia. 60 cm 28 28 0 17/10/2013 8:00 17/10/2013 8:00 13/11/2013 16:00 13/11/2013 16:00 Rp147.065.647,20 Rp147.065.647,20 Rp0,00 Rp0,00

32 Sambungan Expansi (Expansion Joint) Fix 28 28 0 21/11/2013 8:00 21/11/2013 8:00 18/12/2013 16:00 18/12/2013 16:00 Rp26.000.000,00 Rp26.000.000,00 Rp0,00 Rp0,00

33 Sambungan Expansi (Expansion Joint) Move 28 28 0 21/11/2013 8:00 21/11/2013 8:00 18/12/2013 16:00 18/12/2013 16:00 Rp31.200.000,00 Rp31.200.000,00 Rp0,00 Rp0,00

34 Bearing Pad dengan aksesoris ukuran (400 x 350 x 39 mm) 28 28 0 21/11/2013 8:00 21/11/2013 8:00 18/12/2013 16:00 18/12/2013 16:00 Rp20.000.000,00 Rp20.000.000,00 Rp0,00 Rp0,00

35 Rubber Pad dengan aksesoris ukuran (400 x 350 x 39 mm) 28 28 0 21/11/2013 8:00 21/11/2013 8:00 18/12/2013 16:00 18/12/2013 16:00 Rp25.000.000,00 Rp25.000.000,00 Rp0,00 Rp0,00

36 Rubber Strip ukuran (200 x 200 x 10 mm) 28 28 0 21/11/2013 8:00 21/11/2013 8:00 18/12/2013 16:00 18/12/2013 16:00 Rp24.000.000,00 Rp24.000.000,00 Rp0,00 Rp0,00

37 PEKERJAAN LAIN-LAIN 42 36,79 -5,21 05/12/2013 8:00 29/11/2013 14:33 15/01/2014 16:00 05/01/2014 13:06 Rp395.204.885,00 Rp403.974.534,60 Rp8.769.649,60 Rp9.838.125,90 (1.683.234,09)Rp     

38 Pagar Pengaman / Railling, Tipe 1 (Tangga) 28 28 0 19/12/2013 8:00 08/12/2013 13:06 15/01/2014 16:00 05/01/2014 13:06 Rp257.723.572,00 Rp257.723.572,00 Rp0,00 Rp0,00

39 Pagar Pengaman / Railling, Tipe 2 (Jembatan) 28 22,79 -5,21 05/12/2013 8:00 29/11/2013 14:33 01/01/2014 16:00 22/12/2013 13:06 Rp137.481.313,00 Rp146.250.962,60 Rp8.769.649,60 Rp9.838.125,90 (1.683.234,09)Rp     

Cost

Cost Variance Overtime Cost Cost Slope
No 

Task.
Task Name

Duration
Duration 

Variance

Start Finish



Perbandingan Kondisi Normal dengan Penambahan Lembur 3 Jam

Normal
Lembur 3 

Jam
Normal Lembur 3 Jam Normal Lembur 3 Jam Normal Lembur 3 Jam

1

PEMBANGUNAN JEMBATAN PENYEBERANGAN ORANG ( JPO ) KM 30+000 DAN KM 30+600 

PADA JALAN TOL CAWANG - TOMANG - CENGKARENG 126 119,54 -6,46 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 16/01/2014 11:47 Rp3.523.060.709,46 Rp3.657.160.089,52 Rp134.099.380,06 Rp184.476.272,91 (20.758.417,97)Rp   

2 UMUM 126 119,54 -6,46 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 16/01/2014 11:47 Rp245.523.200,00 Rp269.899.816,15 Rp24.376.616,15 Rp46.802.719,70 (3.773.469,99)Rp     

3 JEMBATAN PENYEBRANGAN STA 30+000 126 119,54 -6,46 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 16/01/2014 11:47 Rp122.761.600,00 Rp134.949.908,08 Rp12.188.308,08 Rp23.401.359,85 (1.886.735,00)Rp     

4 Pemeliharaan dan Perlindungan Lalu Lintas 126 96,92 -29,08 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 24/12/2013 15:28 Rp92.761.600,00 Rp104.949.908,08 Rp12.188.308,08 Rp23.401.359,85 (419.130,26)Rp        

5 Mobilisasi (yang tidak Tercakup pada 1.20(1) 126 119,54 -6,46 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 16/01/2014 11:47 Rp30.000.000,00 Rp30.000.000,00 Rp0,00 Rp0,00 -Rp                        

6 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag awal 14 14 0 19/09/2013 8:00 19/09/2013 8:00 02/10/2013 16:00 02/10/2013 16:00 Rp15.000.000,00 Rp15.000.000,00 Rp0,00 Rp0,00

7 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag akhir 14 14 0 09/01/2014 8:00 02/01/2014 11:47 22/01/2014 16:00 16/01/2014 11:47 Rp15.000.000,00 Rp15.000.000,00 Rp0,00 Rp0,00

8 JEMBATAN PENYEBRANGAN STA 30+600 126 119,54 -6,46 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 16/01/2014 11:47 Rp122.761.600,00 Rp134.949.908,08 Rp12.188.308,08 Rp23.401.359,85 (1.886.735,00)Rp     

9 Pemeliharaan dan Perlindungan Lalu Lintas 126 96,92 -29,08 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 24/12/2013 15:28 Rp92.761.600,00 Rp104.949.908,08 Rp12.188.308,08 Rp23.401.359,85 (419.130,26)Rp        

10 Mobilisasi (yang tidak Tercakup pada 1.20(1) 126 119,54 -6,46 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 16/01/2014 11:47 Rp30.000.000,00 Rp30.000.000,00 Rp0,00 Rp0,00 -Rp                        

11 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag awal 14 14 0 19/09/2013 8:00 19/09/2013 8:00 02/10/2013 16:00 02/10/2013 16:00 Rp15.000.000,00 Rp15.000.000,00 Rp0,00 Rp0,00

12 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag akhir 14 14 0 09/01/2014 8:00 02/01/2014 11:47 22/01/2014 16:00 16/01/2014 11:47 Rp15.000.000,00 Rp15.000.000,00 Rp0,00 Rp0,00

13 PEMBONGKARAN 28 28 0 12/12/2013 8:00 12/12/2013 8:00 08/01/2014 16:00 08/01/2014 16:00 Rp70.000.000,00 Rp70.000.000,00 Rp0,00 Rp0,00

14 Pembongkaran Jembatan (JPO) Eksisting 28 28 0 12/12/2013 8:00 12/12/2013 8:00 08/01/2014 16:00 08/01/2014 16:00 Rp70.000.000,00 Rp70.000.000,00 Rp0,00 Rp0,00

15 GALIAN STRUKTUR 35 35 0 03/10/2013 8:00 03/10/2013 8:00 06/11/2013 16:00 06/11/2013 16:00 Rp25.714.000,00 Rp25.714.000,00 Rp0,00 Rp0,00

16 Penggalian Struktur sampai kedalaman tidak lebih dari  2 m 35 35 0 03/10/2013 8:00 03/10/2013 8:00 06/11/2013 16:00 06/11/2013 16:00 Rp23.944.000,00 Rp23.944.000,00 Rp0,00 Rp0,00

17 Penggalian Struktur sampai kedalaman lebih dari  2 m, tapi tidak lebih dari 4 m 35 35 0 03/10/2013 8:00 03/10/2013 8:00 06/11/2013 16:00 06/11/2013 16:00 Rp1.770.000,00 Rp1.770.000,00 Rp0,00 Rp0,00

18 DRAINASE 35 35 0 07/11/2013 8:00 07/11/2013 8:00 11/12/2013 16:00 11/12/2013 16:00 Rp34.126.875,00 Rp34.126.875,00 Rp0,00 Rp0,00

19 Pipa drainase Ø 20 cm dengan perlengkapan sambungan dan penyangga 35 35 0 07/11/2013 8:00 07/11/2013 8:00 11/12/2013 16:00 11/12/2013 16:00 Rp28.251.875,00 Rp28.251.875,00 Rp0,00 Rp0,00

20 Deck Drain beserta asessorisnya, type 1 35 35 0 07/11/2013 8:00 07/11/2013 8:00 11/12/2013 16:00 11/12/2013 16:00 Rp5.875.000,00 Rp5.875.000,00 Rp0,00 Rp0,00

21 STRUKTUR BETON 91 84,54 -6,46 10/10/2013 8:00 10/10/2013 8:00 08/01/2014 16:00 02/01/2014 11:47 Rp2.752.491.749,46 Rp2.849.088.050,95 Rp96.596.301,49 Rp123.202.405,19 (14.952.987,85)Rp   

22 Beton Klass B-1-1 (Plat Jembatan) 28 28 0 12/12/2013 8:00 05/12/2013 11:47 08/01/2014 16:00 02/01/2014 11:47 Rp128.613.248,16 Rp128.613.248,16 Rp0,00 Rp0,00

23 Beton Klass B-1-2 (Beton Tangga) 42 42 0 14/11/2013 8:00 07/11/2013 11:47 25/12/2013 16:00 19/12/2013 11:47 Rp270.759.197,20 Rp270.759.197,20 Rp0,00 Rp0,00

24 Beton Klass B-4-1 (Pier Head) 28 21,54 -6,46 21/11/2013 8:00 14/11/2013 11:47 18/12/2013 16:00 06/12/2013 8:34 Rp58.215.269,10 Rp81.047.918,30 Rp22.832.649,20 Rp24.992.535,25 (3.534.465,82)Rp     

25 Beton Klass B-4-2 (Coloums Pier + Wall Pier) 28 21,54 -6,46 07/11/2013 8:00 07/11/2013 8:00 04/12/2013 16:00 28/11/2013 11:47 Rp57.797.479,90 Rp82.296.324,75 Rp24.498.844,85 Rp26.917.368,51 (3.792.390,84)Rp     

26 Beton Klass C-1 (Abutment, Footing of Pier) 28 28 0 31/10/2013 8:00 31/10/2013 8:00 27/11/2013 16:00 27/11/2013 16:00 Rp194.576.650,90 Rp194.576.650,90 Rp0,00 Rp0,00

27 Beton Klass E (Lantai Kerja) 28 28 0 24/10/2013 8:00 24/10/2013 8:00 20/11/2013 16:00 20/11/2013 16:00 Rp12.661.350,00 Rp12.661.350,00 Rp0,00 Rp0,00

28 Baja Tulangan Ulir 84 64,62 -19,38 17/10/2013 8:00 17/10/2013 8:00 08/01/2014 16:00 20/12/2013 13:20 Rp852.326.583,00 Rp901.591.390,44 Rp49.264.807,44 Rp71.292.501,44 (2.542.043,73)Rp     

29 P.C.I. Girder, Bentang = 23,60 m, H = 1,60 m 77 77 0 17/10/2013 8:00 17/10/2013 8:00 01/01/2014 16:00 01/01/2014 16:00 Rp318.958.570,00 Rp318.958.570,00 Rp0,00 Rp0,00

30 Penyediaan Tiang Pancang  Beton Bulat Pretensioned Dia. 60 cm 28 28 0 10/10/2013 8:00 10/10/2013 8:00 06/11/2013 16:00 06/11/2013 16:00 Rp585.317.754,00 Rp585.317.754,00 Rp0,00 Rp0,00

31 Pemancangan Tiang Pancang  Beton Bulat Pretensioned Dia. 60 cm 28 28 0 17/10/2013 8:00 17/10/2013 8:00 13/11/2013 16:00 13/11/2013 16:00 Rp147.065.647,20 Rp147.065.647,20 Rp0,00 Rp0,00

32 Sambungan Expansi (Expansion Joint) Fix 28 28 0 21/11/2013 8:00 21/11/2013 8:00 18/12/2013 16:00 18/12/2013 16:00 Rp26.000.000,00 Rp26.000.000,00 Rp0,00 Rp0,00

33 Sambungan Expansi (Expansion Joint) Move 28 28 0 21/11/2013 8:00 21/11/2013 8:00 18/12/2013 16:00 18/12/2013 16:00 Rp31.200.000,00 Rp31.200.000,00 Rp0,00 Rp0,00

34 Bearing Pad dengan aksesoris ukuran (400 x 350 x 39 mm) 28 28 0 21/11/2013 8:00 21/11/2013 8:00 18/12/2013 16:00 18/12/2013 16:00 Rp20.000.000,00 Rp20.000.000,00 Rp0,00 Rp0,00

35 Rubber Pad dengan aksesoris ukuran (400 x 350 x 39 mm) 28 28 0 21/11/2013 8:00 21/11/2013 8:00 18/12/2013 16:00 18/12/2013 16:00 Rp25.000.000,00 Rp25.000.000,00 Rp0,00 Rp0,00

36 Rubber Strip ukuran (200 x 200 x 10 mm) 28 28 0 21/11/2013 8:00 21/11/2013 8:00 18/12/2013 16:00 18/12/2013 16:00 Rp24.000.000,00 Rp24.000.000,00 Rp0,00 Rp0,00

37 PEKERJAAN LAIN-LAIN 42 35,54 -6,46 05/12/2013 8:00 28/11/2013 11:47 15/01/2014 16:00 03/01/2014 8:35 Rp395.204.885,00 Rp408.331.347,42 Rp13.126.462,42 Rp14.471.148,02 (2.031.960,13)Rp     

38 Pagar Pengaman / Railling, Tipe 1 (Tangga) 28 28 0 19/12/2013 8:00 06/12/2013 8:35 15/01/2014 16:00 03/01/2014 8:35 Rp257.723.572,00 Rp257.723.572,00 Rp0,00 Rp0,00

39 Pagar Pengaman / Railling, Tipe 2 (Jembatan) 28 21,54 -6,46 05/12/2013 8:00 28/11/2013 11:47 01/01/2014 16:00 20/12/2013 8:35 Rp137.481.313,00 Rp150.607.775,42 Rp13.126.462,42 Rp14.471.148,02 (2.031.960,13)Rp     

Cost

Cost Variance Overtime Cost Cost Slope
No 

Task.
Task Name

Duration
Duration 

Variance

Start Finish



Perbandingan Kondisi Normal dengan Penambahan Lembur 4 Jam

Normal
Lembur 4 

Jam
Normal Lembur 4 Jam Normal Lembur 4 Jam Normal Lembur 4 Jam

1

PEMBANGUNAN JEMBATAN PENYEBERANGAN ORANG ( JPO ) KM 30+000 DAN KM 30+600 

PADA JALAN TOL CAWANG - TOMANG - CENGKARENG 126 119 -7 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 15/01/2014 16:00 Rp3.523.060.709,46 Rp3.709.594.308,26 Rp186.533.598,81 Rp242.336.909,56 (26.647.656,97)Rp   

2 UMUM 126 119 -7 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 15/01/2014 16:00 Rp245.523.200,00 Rp281.925.193,58 Rp36.401.993,58 Rp61.292.571,52 (5.200.284,80)Rp     

3 JEMBATAN PENYEBRANGAN STA 30+000 126 119 -7 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 15/01/2014 16:00 Rp122.761.600,00 Rp140.962.596,79 Rp18.200.996,79 Rp30.646.285,76 (2.600.142,40)Rp     

4 Pemeliharaan dan Perlindungan Lalu Lintas 126 93,83 -32,17 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 21/12/2013 14:50 Rp92.761.600,00 Rp110.962.596,79 Rp18.200.996,79 Rp30.646.285,76 (565.775,47)Rp        

5 Mobilisasi (yang tidak Tercakup pada 1.20(1) 126 119 -7 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 15/01/2014 16:00 Rp30.000.000,00 Rp30.000.000,00 Rp0,00 Rp0,00 -Rp                        

6 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag awal 14 14 0 19/09/2013 8:00 19/09/2013 8:00 02/10/2013 16:00 02/10/2013 16:00 Rp15.000.000,00 Rp15.000.000,00 Rp0,00 Rp0,00

7 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag akhir 14 14 0 09/01/2014 8:00 02/01/2014 8:00 22/01/2014 16:00 15/01/2014 16:00 Rp15.000.000,00 Rp15.000.000,00 Rp0,00 Rp0,00

8 JEMBATAN PENYEBRANGAN STA 30+600 126 119 -7 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 15/01/2014 16:00 Rp122.761.600,00 Rp140.962.596,79 Rp18.200.996,79 Rp30.646.285,76 (2.600.142,40)Rp     

9 Pemeliharaan dan Perlindungan Lalu Lintas 126 93,83 -32,17 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 21/12/2013 14:50 Rp92.761.600,00 Rp110.962.596,79 Rp18.200.996,79 Rp30.646.285,76 (565.775,47)Rp        

10 Mobilisasi (yang tidak Tercakup pada 1.20(1) 126 119 -7 19/09/2013 8:00 19/09/2013 8:00 22/01/2014 16:00 15/01/2014 16:00 Rp30.000.000,00 Rp30.000.000,00 Rp0,00 Rp0,00 -Rp                        

11 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag awal 14 14 0 19/09/2013 8:00 19/09/2013 8:00 02/10/2013 16:00 02/10/2013 16:00 Rp15.000.000,00 Rp15.000.000,00 Rp0,00 Rp0,00

12 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag akhir 14 14 0 09/01/2014 8:00 02/01/2014 8:00 22/01/2014 16:00 15/01/2014 16:00 Rp15.000.000,00 Rp15.000.000,00 Rp0,00 Rp0,00

13 PEMBONGKARAN 28 28 0 12/12/2013 8:00 12/12/2013 8:00 08/01/2014 16:00 08/01/2014 16:00 Rp70.000.000,00 Rp70.000.000,00 Rp0,00 Rp0,00

14 Pembongkaran Jembatan (JPO) Eksisting 28 28 0 12/12/2013 8:00 12/12/2013 8:00 08/01/2014 16:00 08/01/2014 16:00 Rp70.000.000,00 Rp70.000.000,00 Rp0,00 Rp0,00

15 GALIAN STRUKTUR 35 35 0 03/10/2013 8:00 03/10/2013 8:00 06/11/2013 16:00 06/11/2013 16:00 Rp25.714.000,00 Rp25.714.000,00 Rp0,00 Rp0,00

16 Penggalian Struktur sampai kedalaman tidak lebih dari  2 m 35 35 0 03/10/2013 8:00 03/10/2013 8:00 06/11/2013 16:00 06/11/2013 16:00 Rp23.944.000,00 Rp23.944.000,00 Rp0,00 Rp0,00

17 Penggalian Struktur sampai kedalaman lebih dari  2 m, tapi tidak lebih dari 4 m 35 35 0 03/10/2013 8:00 03/10/2013 8:00 06/11/2013 16:00 06/11/2013 16:00 Rp1.770.000,00 Rp1.770.000,00 Rp0,00 Rp0,00

18 DRAINASE 35 35 0 07/11/2013 8:00 07/11/2013 8:00 11/12/2013 16:00 11/12/2013 16:00 Rp34.126.875,00 Rp34.126.875,00 Rp0,00 Rp0,00

19 Pipa drainase Ø 20 cm dengan perlengkapan sambungan dan penyangga 35 35 0 07/11/2013 8:00 07/11/2013 8:00 11/12/2013 16:00 11/12/2013 16:00 Rp28.251.875,00 Rp28.251.875,00 Rp0,00 Rp0,00

20 Deck Drain beserta asessorisnya, type 1 35 35 0 07/11/2013 8:00 07/11/2013 8:00 11/12/2013 16:00 11/12/2013 16:00 Rp5.875.000,00 Rp5.875.000,00 Rp0,00 Rp0,00

21 STRUKTUR BETON 91 84 -7 10/10/2013 8:00 10/10/2013 8:00 08/01/2014 16:00 01/01/2014 16:00 Rp2.752.491.749,46 Rp2.885.104.069,71 Rp132.612.320,25 Rp162.025.988,16 (18.944.617,18)Rp   

22 Beton Klass B-1-1 (Plat Jembatan) 28 28 0 12/12/2013 8:00 04/12/2013 14:57 08/01/2014 16:00 01/01/2014 14:57 Rp128.613.248,16 Rp128.613.248,16 Rp0,00 Rp0,00

23 Beton Klass B-1-2 (Beton Tangga) 42 42 0 14/11/2013 8:00 06/11/2013 14:57 25/12/2013 16:00 18/12/2013 14:57 Rp270.759.197,20 Rp270.759.197,20 Rp0,00 Rp0,00

24 Beton Klass B-4-1 (Pier Head) 28 20,85 -7,15 21/11/2013 8:00 13/11/2013 14:57 18/12/2013 16:00 04/12/2013 13:54 Rp58.215.269,10 Rp88.748.910,78 Rp30.533.641,68 Rp32.933.882,28 (4.270.439,40)Rp     

25 Beton Klass B-4-2 (Coloums Pier + Wall Pier) 28 20,85 -7,15 07/11/2013 8:00 07/11/2013 8:00 04/12/2013 16:00 27/11/2013 14:57 Rp57.797.479,90 Rp90.594.866,28 Rp32.797.386,38 Rp35.472.459,19 (4.587.047,05)Rp     

26 Beton Klass C-1 (Abutment, Footing of Pier) 28 28 0 31/10/2013 8:00 31/10/2013 8:00 27/11/2013 16:00 27/11/2013 16:00 Rp194.576.650,90 Rp194.576.650,90 Rp0,00 Rp0,00

27 Beton Klass E (Lantai Kerja) 28 28 0 24/10/2013 8:00 24/10/2013 8:00 20/11/2013 16:00 20/11/2013 16:00 Rp12.661.350,00 Rp12.661.350,00 Rp0,00 Rp0,00

28 Baja Tulangan Ulir 84 62,55 -21,45 17/10/2013 8:00 17/10/2013 8:00 08/01/2014 16:00 18/12/2013 11:51 Rp852.326.583,00 Rp921.607.875,19 Rp69.281.292,19 Rp93.619.646,69 (3.229.897,07)Rp     

29 P.C.I. Girder, Bentang = 23,60 m, H = 1,60 m 77 77 0 17/10/2013 8:00 17/10/2013 8:00 01/01/2014 16:00 01/01/2014 16:00 Rp318.958.570,00 Rp318.958.570,00 Rp0,00 Rp0,00

30 Penyediaan Tiang Pancang  Beton Bulat Pretensioned Dia. 60 cm 28 28 0 10/10/2013 8:00 10/10/2013 8:00 06/11/2013 16:00 06/11/2013 16:00 Rp585.317.754,00 Rp585.317.754,00 Rp0,00 Rp0,00

31 Pemancangan Tiang Pancang  Beton Bulat Pretensioned Dia. 60 cm 28 28 0 17/10/2013 8:00 17/10/2013 8:00 13/11/2013 16:00 13/11/2013 16:00 Rp147.065.647,20 Rp147.065.647,20 Rp0,00 Rp0,00

32 Sambungan Expansi (Expansion Joint) Fix 28 28 0 21/11/2013 8:00 21/11/2013 8:00 18/12/2013 16:00 18/12/2013 16:00 Rp26.000.000,00 Rp26.000.000,00 Rp0,00 Rp0,00

33 Sambungan Expansi (Expansion Joint) Move 28 28 0 21/11/2013 8:00 21/11/2013 8:00 18/12/2013 16:00 18/12/2013 16:00 Rp31.200.000,00 Rp31.200.000,00 Rp0,00 Rp0,00

34 Bearing Pad dengan aksesoris ukuran (400 x 350 x 39 mm) 28 28 0 21/11/2013 8:00 21/11/2013 8:00 18/12/2013 16:00 18/12/2013 16:00 Rp20.000.000,00 Rp20.000.000,00 Rp0,00 Rp0,00

35 Rubber Pad dengan aksesoris ukuran (400 x 350 x 39 mm) 28 28 0 21/11/2013 8:00 21/11/2013 8:00 18/12/2013 16:00 18/12/2013 16:00 Rp25.000.000,00 Rp25.000.000,00 Rp0,00 Rp0,00

36 Rubber Strip ukuran (200 x 200 x 10 mm) 28 28 0 21/11/2013 8:00 21/11/2013 8:00 18/12/2013 16:00 18/12/2013 16:00 Rp24.000.000,00 Rp24.000.000,00 Rp0,00 Rp0,00

37 PEKERJAAN LAIN-LAIN 42 34,85 -7,15 05/12/2013 8:00 27/11/2013 14:57 15/01/2014 16:00 01/01/2014 13:55 Rp395.204.885,00 Rp412.724.169,98 Rp17.519.284,98 Rp19.018.349,88 (2.450.249,65)Rp     

38 Pagar Pengaman / Railling, Tipe 1 (Tangga) 28 28 0 19/12/2013 8:00 04/12/2013 13:55 15/01/2014 16:00 01/01/2014 13:55 Rp257.723.572,00 Rp257.723.572,00 Rp0,00 Rp0,00

39 Pagar Pengaman / Railling, Tipe 2 (Jembatan) 28 20,85 -7,15 05/12/2013 8:00 27/11/2013 14:57 01/01/2014 16:00 18/12/2013 13:55 Rp137.481.313,00 Rp155.000.597,98 Rp17.519.284,98 Rp19.018.349,88 (2.450.249,65)Rp     

Cost

Cost Variance Overtime Cost Cost Slope
No 

Task.
Task Name

Duration
Duration 

Variance

Start Finish



Rekapitulasi Perbandingan Kondisi Normal dan Kondisi Kompresi

Normal Lembur 1 jam Lembur 2 jam Lembur 3 jam Lembur 4 jam Normal Lembur 1 jam Lembur 2 jam Lembur 3 jam Lembur 4 jam

1

PEMBANGUNAN JEMBATAN PENYEBERANGAN ORANG ( JPO ) KM 30+000 DAN KM 30+600 PADA 

JALAN TOL CAWANG - TOMANG - CENGKARENG 126 122,81 120,79 119,54 119 Rp3.523.060.709,46 Rp3.559.329.253,96 Rp3.608.100.449,23 Rp3.657.160.089,52 Rp3.709.594.308,26

2 UMUM 126 122,81 120,79 119,54 119 Rp245.523.200,00 Rp250.710.992,43 Rp259.644.617,77 Rp269.899.816,15 Rp281.925.193,58

3 JEMBATAN PENYEBRANGAN STA 30+000 126 122,81 120,79 119,54 119 Rp122.761.600,00 Rp125.355.496,21 Rp129.822.308,89 Rp134.949.908,08 Rp140.962.596,79

4 Pemeliharaan dan Perlindungan Lalu Lintas 126 111,65 102,56 96,92 93,83 Rp92.761.600,00 Rp95.355.496,21 Rp99.822.308,89 Rp104.949.908,08 Rp110.962.596,79

5 Mobilisasi (yang tidak Tercakup pada 1.20(1) 126 122,81 120,79 119,54 119 Rp30.000.000,00 Rp30.000.000,00 Rp30.000.000,00 Rp30.000.000,00 Rp30.000.000,00

6 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag awal 14 14 14 14 14 Rp15.000.000,00 Rp15.000.000,00 Rp15.000.000,00 Rp15.000.000,00 Rp15.000.000,00

7 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag akhir 14 14 14 14 14 Rp15.000.000,00 Rp15.000.000,00 Rp15.000.000,00 Rp15.000.000,00 Rp15.000.000,00

8 JEMBATAN PENYEBRANGAN STA 30+600 126 122,81 120,79 119,54 119 Rp122.761.600,00 Rp125.355.496,21 Rp129.822.308,89 Rp134.949.908,08 Rp140.962.596,79

9 Pemeliharaan dan Perlindungan Lalu Lintas 126 111,65 102,56 96,92 93,83 Rp92.761.600,00 Rp95.355.496,21 Rp99.822.308,89 Rp104.949.908,08 Rp110.962.596,79

10 Mobilisasi (yang tidak Tercakup pada 1.20(1) 126 122,81 120,79 119,54 119 Rp30.000.000,00 Rp30.000.000,00 Rp30.000.000,00 Rp30.000.000,00 Rp30.000.000,00

11 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag awal 14 14 14 14 14 Rp15.000.000,00 Rp15.000.000,00 Rp15.000.000,00 Rp15.000.000,00 Rp15.000.000,00

12 Mobilisasi (yang tidak Tercakup pada 1.20(1) bag akhir 14 14 14 14 14 Rp15.000.000,00 Rp15.000.000,00 Rp15.000.000,00 Rp15.000.000,00 Rp15.000.000,00

13 PEMBONGKARAN 28 28 28 28 28 Rp70.000.000,00 Rp70.000.000,00 Rp70.000.000,00 Rp70.000.000,00 Rp70.000.000,00

14 Pembongkaran Jembatan (JPO) Eksisting 28 28 28 28 28 Rp70.000.000,00 Rp70.000.000,00 Rp70.000.000,00 Rp70.000.000,00 Rp70.000.000,00

15 GALIAN STRUKTUR 35 35 35 35 35 Rp25.714.000,00 Rp25.714.000,00 Rp25.714.000,00 Rp25.714.000,00 Rp25.714.000,00

16 Penggalian Struktur sampai kedalaman tidak lebih dari  2 m 35 35 35 35 35 Rp23.944.000,00 Rp23.944.000,00 Rp23.944.000,00 Rp23.944.000,00 Rp23.944.000,00

17 Penggalian Struktur sampai kedalaman lebih dari  2 m, tapi tidak lebih dari 4 m 35 35 35 35 35 Rp1.770.000,00 Rp1.770.000,00 Rp1.770.000,00 Rp1.770.000,00 Rp1.770.000,00

18 DRAINASE 35 35 35 35 35 Rp34.126.875,00 Rp34.126.875,00 Rp34.126.875,00 Rp34.126.875,00 Rp34.126.875,00

19 Pipa drainase Ø 20 cm dengan perlengkapan sambungan dan penyangga 35 35 35 35 35 Rp28.251.875,00 Rp28.251.875,00 Rp28.251.875,00 Rp28.251.875,00 Rp28.251.875,00

20 Deck Drain beserta asessorisnya, type 1 35 35 35 35 35 Rp5.875.000,00 Rp5.875.000,00 Rp5.875.000,00 Rp5.875.000,00 Rp5.875.000,00

21 STRUKTUR BETON 91 87,81 85,79 84,54 84 Rp2.752.491.749,46 Rp2.779.441.890,13 Rp2.814.640.421,86 Rp2.849.088.050,95 Rp2.885.104.069,71

22 Beton Klass B-1-1 (Plat Jembatan) 28 28 28 28 28 Rp128.613.248,16 Rp128.613.248,16 Rp128.613.248,16 Rp128.613.248,16 Rp128.613.248,16

23 Beton Klass B-1-2 (Beton Tangga) 42 42 42 42 42 Rp270.759.197,20 Rp270.759.197,20 Rp270.759.197,20 Rp270.759.197,20 Rp270.759.197,20

24 Beton Klass B-4-1 (Pier Head) 28 24,81 22,79 21,54 20,85 Rp58.215.269,10 Rp65.202.601,40 Rp73.390.208,37 Rp81.047.918,30 Rp88.748.910,78

25 Beton Klass B-4-2 (Coloums Pier + Wall Pier) 28 24,81 22,79 21,54 20,85 Rp57.797.479,90 Rp65.213.428,88 Rp74.041.229,98 Rp82.296.324,75 Rp90.594.866,28

26 Beton Klass C-1 (Abutment, Footing of Pier) 28 28 28 28 28 Rp194.576.650,90 Rp194.576.650,90 Rp194.576.650,90 Rp194.576.650,90 Rp194.576.650,90

27 Beton Klass E (Lantai Kerja) 28 28 28 28 28 Rp12.661.350,00 Rp12.661.350,00 Rp12.661.350,00 Rp12.661.350,00 Rp12.661.350,00

28 Baja Tulangan Ulir 84 74,43 68,37 64,62 62,55 Rp852.326.583,00 Rp864.873.442,40 Rp883.056.566,05 Rp901.591.390,44 Rp921.607.875,19

29 P.C.I. Girder, Bentang = 23,60 m, H = 1,60 m 77 77 77 77 77 Rp318.958.570,00 Rp318.958.570,00 Rp318.958.570,00 Rp318.958.570,00 Rp318.958.570,00

30 Penyediaan Tiang Pancang  Beton Bulat Pretensioned Dia. 60 cm 28 28 28 28 28 Rp585.317.754,00 Rp585.317.754,00 Rp585.317.754,00 Rp585.317.754,00 Rp585.317.754,00

31 Pemancangan Tiang Pancang  Beton Bulat Pretensioned Dia. 60 cm 28 28 28 28 28 Rp147.065.647,20 Rp147.065.647,20 Rp147.065.647,20 Rp147.065.647,20 Rp147.065.647,20

32 Sambungan Expansi (Expansion Joint) Fix 28 28 28 28 28 Rp26.000.000,00 Rp26.000.000,00 Rp26.000.000,00 Rp26.000.000,00 Rp26.000.000,00

33 Sambungan Expansi (Expansion Joint) Move 28 28 28 28 28 Rp31.200.000,00 Rp31.200.000,00 Rp31.200.000,00 Rp31.200.000,00 Rp31.200.000,00

34 Bearing Pad dengan aksesoris ukuran (400 x 350 x 39 mm) 28 28 28 28 28 Rp20.000.000,00 Rp20.000.000,00 Rp20.000.000,00 Rp20.000.000,00 Rp20.000.000,00

35 Rubber Pad dengan aksesoris ukuran (400 x 350 x 39 mm) 28 28 28 28 28 Rp25.000.000,00 Rp25.000.000,00 Rp25.000.000,00 Rp25.000.000,00 Rp25.000.000,00

36 Rubber Strip ukuran (200 x 200 x 10 mm) 28 28 28 28 28 Rp24.000.000,00 Rp24.000.000,00 Rp24.000.000,00 Rp24.000.000,00 Rp24.000.000,00

37 PEKERJAAN LAIN-LAIN 42 38,81 36,79 35,54 34,85 Rp395.204.885,00 Rp399.335.496,40 Rp403.974.534,60 Rp408.331.347,42 Rp412.724.169,98

38 Pagar Pengaman / Railling, Tipe 1 (Tangga) 28 28 28 28 28 Rp257.723.572,00 Rp257.723.572,00 Rp257.723.572,00 Rp257.723.572,00 Rp257.723.572,00

39 Pagar Pengaman / Railling, Tipe 2 (Jembatan) 28 24,81 22,79 21,54 20,85 Rp137.481.313,00 Rp141.611.924,40 Rp146.250.962,60 Rp150.607.775,42 Rp155.000.597,98

No 

Task.

Durasi Biaya
Nama Kegiatan



Rekapitulasi Biaya dan Waktu
Optimum dari Setiap Kompresi

1 Normal 126 3.523.060.709,46Rp    3.100.293.424,32Rp    422.767.285,13Rp       

2 Lembur 1 jam 122,81 3,19 3.559.329.253,96Rp    3.147.265.362,79Rp    412.063.891,17Rp       36.268.544,50Rp         11.369.449,69Rp         60.787.335,27Rp      

3 Lembur 2 jam 120,79 5,21 3.608.100.449,23Rp    3.202.814.255,80Rp    405.286.193,42Rp       85.039.739,77Rp         16.322.406,87Rp         125.519.660,60Rp    

4 Lembur 3 jam 119,54 6,46 3.657.160.089,52Rp    3.256.068.015,99Rp    401.092.073,53Rp       134.099.380,06Rp       20.758.417,97Rp         184.476.272,91Rp    

5 Lembur 4 jam 119 7 3.709.594.308,26Rp    3.310.314.094,53Rp    399.280.213,74Rp       186.533.598,81Rp       26.647.656,97Rp         242.336.909,56Rp    

Perubahan biaya
Biaya Total Biaya Langsung Biaya Tidak Langsung

No. Kondisi

Durasi 

proyek 

(hari)

Perubahan 

durasi 

(hari)

Biaya setelah kompresi optimum

Cost Slope Biaya lembur



Hasil dan Pembahasan

Rp3.500.000.000,00 

Rp3.525.000.000,00 

Rp3.550.000.000,00 

Rp3.575.000.000,00 

Rp3.600.000.000,00 

Rp3.625.000.000,00 

Rp3.650.000.000,00 

Rp3.675.000.000,00 

Rp3.700.000.000,00 

Rp3.725.000.000,00 

Lembur 4 jam Lembur 3 jam Lembur 2 jam Lembur 1 jam Normal

Biaya Total

Rp3.100.000.000,00 

Rp3.125.000.000,00 

Rp3.150.000.000,00 

Rp3.175.000.000,00 

Rp3.200.000.000,00 

Rp3.225.000.000,00 

Rp3.250.000.000,00 

Rp3.275.000.000,00 

Rp3.300.000.000,00 

Biaya Langsung

Rp399.280.213,74 

Rp401.092.073,53 

Rp405.286.193,42 

Rp412.063.891,17 

Rp422.767.285,13 

Biaya Tidak 
Langsung

119

119,54

120,79

122,81

126

Durasi



Perbandingan Penambahan Biaya
dengan Biaya Denda

No. Percepatan Biaya Total Perubahan biaya Keterlambatan (hari) Biaya Denda Kerugian

1 3,19 3.559.329.253,96Rp    36.268.544,50Rp         4 14.092.242,84Rp         (22.176.301,66)Rp        

2 5,21 3.608.100.449,23Rp    85.039.739,77Rp         6 21.138.364,26Rp         (63.901.375,51)Rp        

3 6,46 3.657.160.089,52Rp    134.099.380,06Rp       7 24.661.424,97Rp         (109.437.955,10)Rp      

4 7 3.709.594.308,26Rp    186.533.598,81Rp       7 24.661.424,97Rp         (161.872.173,84)Rp      



Kesimpulan

Berdasarkan data serta hasil analisis dan pembahasan yang dilakukan
pada Pembangunan Penyebrangan Orang KM 30+000 dan KM 36+000
pada Jalan Tol Cawang-Tomang-Cengkareng, dapat ditarik kesimpulan
sebagai berikut :

1. Biaya total minumum proyek diperoleh pada saat kondisi normal tanpa 
penambahan jam lembur sebesar Rp. 3.523.060.709,46 sedangkan untuk 
durasi minimum proyek setelah dilakukan penambahan jam kerja yaitu 
119 hari dari durasi normal 126 hari dengan perubahan durasi sebesar 7 
hari.

2. Pilihan terbaik penambahan jam kerja adalah adalah dengan melakukan 
penambahan satu jam kerja, pada kondisi ini cost slope dari penambahan 
1 jam kerja relatif lebih kecil dibandingkan dengan cost slope dari 
penambahan jam lembur lainnya, yakni sebesar Rp 11.369.449,69.

3. Penambahan jam kerja tidak memberikan keuntungan dibandingkan 
dengan membayar biaya denda.

back
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